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[bookmark: _Toc402880310]SCS Static Management Program (SMP) Installation
The SMP installation procedure is described in full detail in the SMP Installation Guide document. This document will focus on setting up the SMP system for everyday use. As a basic example we will use an imaginary system that monitors four sensors. Note that all of the screen shots have been taken from various older software versions – your software will always show the most recent version installed.
After completing the installation procedure described in the SMP Installation Guide for both SMP Server and SMP Client Applications, the program menu should look like this:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\setup02.png]
	TIP

	Even though it’s not strictly required to install SMP Client Applications on the server computer it is common practice.
It is possible to set up, configure, and maintain the SMP Server from a client (remote) computer but it is often handy to have all of the client applications at hand on the server machine.



SCS SMP Server Monitor is a small utility that runs silently and is indicated by small SCS icon in the system tray. When the mouse cursor hovers over it, information about the server version shows:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\monitor01.png] 
Clicking on the icon brings up a small form:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\monitor02.png] 
One important server feature is automatic device discovery. Once a SCS static control device gets connected to a network serviced by the SCS Static Management Program (SMP) Server, it becomes instantly “visible” to the server. The server creates a database entity for each new device, and automatically self-starts data acquisition. Discovered devices are identified by their unique serial numbers.
The example above shows that the server has software version 1.5.11, it is Active (running) and there are no devices in the system.
Let’s assume for the sake of this walkthrough that we have four SCS WS Aware TNG ESD Event Monitors (four grounds) that are active and connected to the network. SMP Server Monitor reveals:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\monitor03.png] 
	TIP

	SCS sensors connect to a Lantronix hub device that is connected to the network. If SMP doesn’t show that connected devices are active then the most probable cause is a network or configuration issue.	Comment by Shubhamalini, B.H: Do we have required permission from Latonix?
If this happens you should check the Lantronix configuration and device accessibility on the LAN using standard network tools. For further details please contact SCS.



Clicking on Connections reveals further network information:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\monitor04.png]
Four devices in our example are connected to a hub (Lantronix device) at the IP address shown. Each device is shown with its serial number and slot id (Modbus ID). This information may be useful to diagnose any network connectivity problems.	Comment by Carolyn Garber: Modbus is a trademark of Schneider Electric USA.  Please determine if Modbus ID should be attributed as a trademark?  For assistance, please check with Michael Gannon or his paralegal, Carrie Wolf.  I suspect there are also some other software names that may require trademark attributions.  
[bookmark: _Toc402880311]Walkthrough: Using SCS Static Management Program (SMP) Admin to define system structure
The SCS SMP Client connects to the remote SCS SMP Server using network protocol. The server itself is in charge of data acquisition, database maintenance and providing services to all clients. It is important to understand that all activity occurs on the SCS SMP Server, while clients allow facility management to access key server data, status and operations. 
In this walkthrough we will use the SCS SMP Admin application to set up our example system. If we start the SCS SMP Client first it will show:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\client01.png]
Right now, we have only unassigned devices (make sure to remove checkmark from show Assigned only box). If we click on the – unassigned – line link, we will see all the discovered devices as shown here:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\client02.png]
Since the SCS Device Monitoring Server is capable of monitoring up to 1,000 devices simultaneously, it would be next to useless if the user could only view them only in a single large list format identified only by cryptic serial numbers.
For a full description of the SCS Static Management Program (SMP) Client features and functionality see the SMP Users Guide document.
[bookmark: _Toc402880312]Defining System Hierarchy
To make large scale systems more manageable, the SCS Static Management Program (SMP) introduces a hierarchy consisting of four levels: buildings, floors, lines and devices. The system structure is created and maintained using the SCS SMP Admin client application:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin01.png]
In the screen shot above, the system structure is empty. We can change that by adding a building to the system. 
	TIP

	The system structure is hierarchical and it can only be defined from the top down. To define the facility floor, a building must first be created. Once the floor exists that contains the facility’s floor plan, lines may be created, and the devices can be attached to the existing lines.


A new building is added by clicking on the Add New Building button in the right panel:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin02.png]
Let’s create building Main as shown above and follow with creating the floor Operations in the Main building. We will then add two lines, Production and Backup, in Operations.

When we created the building Main it shows in the list of existing buildings. Double-click on its row to enter building details. Use Add New Floor to add floor Operations and double-click on it to enter floor details.
We will finish the system structure definition by adding two lines (Production and Backup) to this line:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin03.png]
Once we have defined the logical system structure (hierarchy) consisting of the building, floors and lines, we can attach real devices to the defined line(s). To achieve this, select Production line and expand the box labeled Attachable Devices (click on circled arrow (1):
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin04.png]
We attach each device using hyperlink marked in blue (2).
We will attach the first two devices to Production, and then repeat this process by attaching the second two devices to the Backup line. The next figure shows how our system looks now (with the Production line selected):
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin05.png]
It is possible to detach assigned devices at any time (blue detach hyperlink) and attach them to some other line, thus rearranging system hierarchy.
Now all we need to do is name devices in a more meaningful way. This is easily done by clicking on the rename hyperlink in the devices list or by switching to a device and clicking on the Rename Device button. Let’s rename the devices to achieve the final result as shown:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin06.png]
If we start SCS Static Management Program (SMP) Client now, we get:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\client03.png]
Note that the devices now have more meaningful names in the alarms list, and there are no unassigned devices. The system shows two lines in the main view.
Observe that both the building and line names in the main view are hyperlinks – they are clickable and will navigate to a related view. The same is not true for the floor. The figure above shows Operations as a disabled link. The reason for this is the view associated to the floor is a graphical map view, and we have not yet defined the floor area within the system.
[bookmark: _Toc402880313]Defining Floor Visualization
The SCS Static Management Program (SMP) Plant Editor client application is a visual editor used to create graphical facility plans with SCS device placement. This application is designed for “offline” usage – it does not connect to the system Server and it doesn’t know anything about the system structure. The purpose of the Plant Editor is simply to create floor plans that will be integrated later into the SCS Device Monitoring System.
Let’s start the Plant Editor and import an existing floor plan (standard raster graphics formats such as JPEG, GIF, PNG, BMP are all supported) using the Tools -> Import Background menu:
[image: ]
The SCS Plant Editor possesses some general purpose drawing tools. We can freely draw polylines, polygons and create text on the plan surface, as well as change the color, shading, font size and thickness attributes. In addition, we can place any number of SCS devices within the graphic.
Let’s start by zooming in on the machine shop (point mouse towards Machine Shop label and use the mouse wheel to zoom in), and draw two workbenches. To draw the workbenches, we will use the Polygon tool, and we will change the Color to Brown by selecting our preference from the colors drop-down in the properties panel.
The status bar in the bottom of the window reveals some useful tips for us, depending on the context of our drawing. With the Polygon tool selected, the status bar shows:
Click on the plan to add polygon points (SHIFT for straight lines, CTRL for alignment with existing points, double click to end)
Holding both CTRL and SHIFT while clicking on nodes, we quickly come to this result:
[image: ]
To finish this example, we will label those two workbenches Production and Backup using the Text tool (LightGray color, font sizes 12 and 16 respectively) and place four SCS WS Aware Dual Workstation Monitors (with four grounds) as shown:
[image: ]
Finally, we will save our newly created floor plan using File -> Save As menu, giving it the name Operations.



We now have our first floor plan, and we are going to wire it to the SCS Device Monitoring System. To accomplish this, we will go to the SCS Static Management Program (SMP) Admin application, select the Operations floor, and click on Edit Plan. The window titled Floor Plan pops out indicating that there is no floor plan (yet). Using the Import Plan menu item we select the Operations.smp file (that is the plan we just created with Plant Editor):
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin07.png]
Red dots inside the device symbols indicate that the devices are not assigned. But before we do that, let’s Save the plan as we have it now and take another side trip to the SCS Static Management Program (SMP) Client.
Once we start the Client, we immediately notice that Operations has become an active link. Clicking on it shows the floor view:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\client04.png]
Our completed floor plan was imported to the server and aligned to the related Operations floor. The device symbols are not shown since the devices are not yet assigned.
For this final step we go back to the SCS Static Management Program (SMP) Admin application. To assign devices we select them in the hierarchical view on the left and drag them to appropriate symbol:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin08.png]
 Once we drop a device onto a symbol, the red dot will vanish and the symbol will change color.
SMP uses a color scheme to indicate a specific line on floor plans. It is easy to select line colors from the drop-down color selection boxes to the left of the line name. With new colors selected and all of the devices assigned, the floor plan will look like this:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin09.png]
Note that selecting a device in the hierarchy view on the right brings that device into focus on the plan and circles it in red. Also note that each assigned device has a tooltip showing device name, serial number, and model.
It is possible to rearrange, reassign, or correct mistakes in assignment by dragging devices from the hierarchy on the left to some other symbol on a map.
We will now save our finished floor plan, thus completing our sample system definition.
If we restart the SCS Device Monitoring Client once again and click on the Operations floor link, we will see our finished system in real-time:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\client05.png]
The device symbols now come alive with color. The bottom part of each symbol shows the associated line color code, and the top part shows the status indicators. Here we have the SCS WS Aware Dual Workstation Monitor with four grounds, as used to cover two workstations. Thus, we have two squares in the upper part of the symbol. Each of those squares shows the real-time status of each respective workstation. The status is also color-coded:
· red – alarm
· yellow/orange - warning
· green – nominal
· gray/black – disconnected (off)
· white – unassigned to system


[bookmark: _Toc402880314]Device configuration
All SCS monitoring devices come preset to most common operational parameters. SCS Static Management Program (SMP) Admin makes fine-tuning those parameters an easy task. The following picture shows Device Front selected and EMI Voltage Limit changed to 400:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin10.png]
Note that the Update button becomes available as soon as a parameter is changed. To approve a pending change, click on the Update button.
Limits set here will directly influence alarms sent by devices. For example, the device in this example will give an alarm if the measured body voltage goes above 2.5 volts (or below -2.5 volts). Configured limits are sent back to the device and stored in its memory.
SCS Static Management Program (SMP) has an additional feature that is important for static monitoring – defining warning levels. In the example above, let’s set the warning levels as shown:
[image: ]
Our example device is set to issue warnings if, for example, body voltage exceeds 1 volt (or falls below -1 volt). This device will warn if body voltage is between 1 and 2.5 volts and alarm if body voltage is higher than 2.5 volts.
Warnings can greatly improve static monitoring and aid in discovering potential problems before they actually cause any damage. The warning feature is described in full detail in the SMP Users Guide document.
	Insight

	Unlike the alarm configuration that is reflected in hardware, warnings are a pure software construct in SMP. They are stored in the SMP database and have no effect on device operation.



	TIP

	To disable warnings for a device, set the warning levels to maximum (same as alarm limit).
This will effectively disable warnings because there won’t be any warning margin left.
Note: this is the default setting.



It is also possible to copy configuration parameters from one device to another device of the same type. This feature may considerably reduce initial system configuration by removing the need to type in the same configuration parameters again and again. In order to copy a configuration from an already configured device:
· select the desired device from the list of available devices next to the Copy from device button (devices of the same type and model only)
· click on Copy from device button
Finally, it is possible to use a device configuration as a “template” and copy it to any number of other devices of the same type and model. Clicking on the Copy Configuration button on the command sidebar brings up a form with a list of all devices in the system of the same type and model. Copying the configuration is as simple as selecting desired target devices and clicking Copy:
[image: ]
[bookmark: _Toc402880315]Device calibration
All SCS monitoring devices require periodic calibration to operate properly. SMP Admin can help manage the calibration schedule. The device page contains a Calibration due input field (with a drop-down calendar for convenience). Use this to set and maintain the due date for calibration, use the Clear button to reset (unset) calibration due date.
	Insight

	New models of SCS monitoring devices will support automatic management of calibration schedule (saving in configuration, alarming if calibration is overdue).
Older models do not have this feature and they require manual calibration calendar management.



There is a Device Calibration Report button [image: ]on the main application toolbar in SMP Admin. Clicking on it will bring up the calibration report window:
[image: ]
The displayed devices are grouped by calibration status (overdue, due soon, not due soon and unknown).
	TIP

	The calibration report button icon will change color to reflect calibration status importance. It will be red if calibration is overdue for some device(s), yellow if it is soon due and so on.



	TIP

	The device calibration report is available both in SMP Admin and SMP Client.
It has exactly the same icon and functionality in both applications.


Finally SMP Admin allows you to copy a calibration due date to any number of other devices. Clicking on Copy Calibration button on the command sidebar will bring up a similar form as Copy Configuration command (but now it contains all devices – not only devices of same model and type).
[bookmark: _Toc402880316]Walkthrough: Managing SCS Static Management Program (SMP) Server Security
SCS SMP is a classic client-server system where the server is publicly available on the network. It is possible to secure SMP access in cases where server is located on a public network (Internet) or when it is desirable to restrict access even in local networks.
[bookmark: _Toc402880317]Creating and Managing Users
SCS SMP Admin has the [image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin11.png] icon on the main application toolbar, and a Users button is available when a server is selected. Clicking on any of these will bring up the Users form. We will use this to create three system users: SCS, Manager and Admin.
To create a new user click on the Create New button and fill in the form on the right side of the window as shown:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin12.png]
Changes are not committed automatically – it is necessary to click on Update.
Each user gets a Role assigned. Available roles are: guest, user, operator, manager, power user, system, admin and master. SMP uses role-based access rights. This means that certain operations require a certain level of access. For example, SMP Admin requires a minimum role level of user to view information and at least a role level of admin to change anything.
	TIP

	Note that each following role includes also all lower ranking roles. For example, power user will also have operator role but will not have admin role.


We will finish user creation by creating two more users (Manager with manager role and Admin with admin role):
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin13.png]
	WARNING!

	If you plan to secure the SCS Static Management Program (SMP) Server, create at least one user with the role admin or higher and store (write) the username and password in a safe place!
Once server security is turned on, it will require admin to change anything.
Losing or forgetting this login information will effectively lock the system.


SMP Server is not secured by default. If we want the server secured then we first have to create users, including at least one with the admin role (as we did above). To bring up the login form we can click on either the [image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin14.png]button in the main application toolbar, or the Login button when the server is selected.
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin15.png]
Only when an administrator (role admin or higher) logs in, does the [image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin16.png] button becomeavailable in the main application toolbar. This button is marked Server Options and clicking on it brings up:
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\admin17.png]
This form has three input fields:
· Requires Authentication – controls SMP security mode. If this option is turned on SMP will require authentication (user login) and authorization (sufficient role) for operation. For example, if security is on then SMP Admin won’t even start without user login.
· Requires Comments – if this option is turned on then SMP Admin will require user comment for any operation that may change device behavior (configuration, calibration). Administrative action auditing is described in detail later in this guide.
· Default Domain – SMP integrates with Active Directory and may use the credentials (password) stored there. For Active Directory users there is no need to store the password in SMP – it will check the domain or local user password. Default domain is the domain used for Active Directory login. Default domain is used only if it is desirable to restrict access only to that domain.
When a user logs in, SMP first tries to authenticate the user against Active Directory. If Default Domain is defined (not blank) then the Domain in the user profile is overridden with it. Active Directory is checked for the user with given name (case insensitive) in the given domain (case insensitive). If the user exists then the entered password is checked.
Note: if Domain is blank then the user with given username is searched on the local computer.
If Active Directory login fails, then SMP checks the password stored in the SMP data store.







	Insight

	Even if an Active Directory user is allowed to access SMP, it is still necessary to add the user to the SCS Static Management Program (SMP) user list. It is not necessary to store a password for those users since SMP will ignore it anyway.
SMP does not encrypt stored passwords in any way – they are stored and visible in SMP Admin to anyone that has access to it. Support for Active Directory login adds an extra layer of security, because user passwords will remain secret.
Active Directory login also makes working with SMP more convenient for users because they can use the same credentials they use to log in to their computer.


We can turn security on and exit SMP Admin.
Let’s open SMP Admin again. Instead of showing a view into the system, it will prompt for login! Try to login with user SCS (role is user). Note that all information is visible and that almost all editing functionality is disabled (grayed out).
Try also to open SCS SMP Client. It will show normally but if you try to dismiss (handle) any alarm you will get a message saying that you are not authorized for the requested operation. Since the server is secured, alarm handling will require at least the role of operator.
Let’s switch back to SMP Admin and log in as user Admin (role is admin). All editing functionality becomes available again.
SMP server security is simple, but it has to be understood well, or some unexpected problems may arise.
[bookmark: _Toc402880318]Role-based rights in SMP
When security is turned on for the SMP system it uses role-based user rights management. This means that SMP will require a minimal role for a certain operation.
SMP roles in order of priority are:
· Guest
· User
· Operator
· Manager
· Power User
· System
· Admin
· Master
Therefore, if a certain operation requires the role of Manager, then a user with the role System is able to perform that operation as well.





Required roles in SMP Admin
· login (start application) – User
· manage Users – Admin
· manage Notifications – Admin
· manage system hierarchy – Admin
· manage devices (rename, attach, configuration) – Admin
· manage problem solution hints – Admin
· change server options – Admin
· review administrative actions – Admin
· show inactive devices– Admin

Required roles in SMP Client
· manage Event Tags – User
· handle alarm – Operator
· change alarm importance – Manager
· show inactive devices– Manager
· show past Events on history or comparison report – Manager



[bookmark: _Toc402880319]Walkthrough: Sending e-mail notifications in the SCS Static Management Program (SMP)
The SMP Server is capable of sending e-mail notifications about Alarms and Faults. Notification messages are sent as HTML e-mail messages with optional Excel attachments. Attachments are used for potentially large tables.
All e-mails are sent using the SMTP protocol. An SMTP mail server has to be available and accessible from the server machine. Unless this condition is met, sending notifications will not work. It is quite common that company security policy forbids outgoing SMTP traffic, or that the port used for communication with mail server is closed on Firewall. System administrator should check all similar conditions and verify that communication with mail server works properly.
	Insight

	The server will not show eventual errors related to SMTP in the user interface – it will only log them to textual log files. Server installation folder will contain those log files and file:
	SMS.Server Exception.log
will contain information regarding those (and other) errors.



SCS SMP Admin has the necessary functionality for the setup, maintenance and administration of all e-mail notification related functions. Once the basic prerequisite of having access to a mail server is fulfilled, all configuration is done in SMP Admin.
	Insight

	SMP Server supports authentication, but it is not required. If the server does not require authentication, any user (local or remote) may be able to change the SMTP settings, mailing options, e-mail recipients, etc.
If the server requires authentication (recommended), then notification-related functions require at least the Admin role.



In SMP Admin, notifications management is available by clicking on the e-mail Notifications button in the server view, or on the [image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\mail01.png] button in the main application toolbar. Here it is possible to set up the mail server connection, define recipients, notification schedule, and strategy.
[bookmark: _Toc402880320]Setting up the Mail Server
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\mail02.png]
Host
Enter the network address of the outgoing mail server.
Port
Enter the port on the mail server that is used for SMTP communications.
Username
Enter the username for connecting to the mail server. The SCS Static Management Program (SMP) server will send the Username/Password credentials to the mail server with every outgoing e-mail.
Password
Enter the password for connecting to the mail server. The SMP server will send the Username/Password credentials to mail server with every outgoing e-mail.
Use SSL
Check the Use SSL box if the mail server requires SSL (secure sockets).
Sender
Enter the common sender for all outgoing e-mails.
NOTE: it is common practice that mail servers use Username as Sender (for example Gmail). If this is the case then content of this field is irrelevant (although still required entry).

e-mail notifications enabled
Enables or disables sending of e-mail notifications. This is a convenient way to turn the whole notifications infrastructure off for troubleshooting. If this option is not selected then all e-mail notification processing halts and SCS Static Management Program (SMP) server does not even try to communicate with mail server.
Update
Click on Update to accept all changes on the form. Changes are NOT saved when data is entered in the fields or when the form closes: changes have to be saved explicitly.
[bookmark: _Toc402880321]Recipients and Notification Options
[image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\mail03.png]
The left part of the form contains a list of defined recipients. Selecting a recipient in the list fills its data in the right part of the form.
Available operations are:
Delete	Comment by Carolyn Garber: Probably want to keep this with the delete explanation. 
The Delete button deletes the currently selected recipient. The delete operation is irreversible but requires confirmation.
Create New
Clears the form on the right side of the window and enables defining a new recipient.
NOTE: clicking Create New does not create new entry; it just clears all form fields and enables a new entry. The new recipient will be created when the Update button is clicked.

Modify existing recipient
Selecting item in left list will show its data in the right form. Clicking on Save will save all modifications.
Recipient data is quite simple – it consists of:
e-mail
Enter the recipient e-mail address. Notifications are sent to this e-mail.
Alarm notifications
Select from a list of options determining notifications about Alarms. Available choices are:
· Never – no alarm notifications for this recipient
· Instant – recipient is notified about every new alarm instantly
· every 15 minutes – every full 15 minutes recipient receives a list of new alarms that occurred during the prior 15 minutes. The alarm list is attached as Excel table.
· every hour – every full hour the recipient receives a list of new alarms occurring during the prior hour. The alarm list is attached as Excel table.
· every 4 hours – cumulative list for last 4 hours sent every full 4 hours (as above).
· once per day – cumulative list for last day sent at 00:00 (as above).
Fault notifications
Select from a list of options determining notifications about Faults. Available choices are:
· Never – no faults notifications for this recipient
· once per day – recipient is notified about all faults in the system during the prior day. E-mail is sent at 00:00
· once per week – recipient is notified about all faults from the prior week every Monday.
· once per month – recipient is notified about all faults from the prior month every 1st day of the month.


The fault list is always attached to e-mail as an Excel document. This document is quite similar to the fault summary table (on the summary view of the fault report in the SCS Static Management Program [SMP] Client). The report contains faults from the whole system – selecting a specific building or floor is not an option. To facilitate analyzing faults per building, floor, line or device level, this report contains some additional tables. The excel document contains following tables:
· Faults by Device Type
· Faults by Alarm Type
· Faults by Device
· Faults by Building
· Faults by Floor
· Faults by Line
Standard Excel tools will easily produce any custom aggregation from those tables.
Send empty alarm notifications
Regulates whether a recipient receives alarm notifications even if there were no alarms in the scheduled period (applies only to periodic alarm notifications). If this option is selected then the system will send an e-mail like:
“There were no alarms in the system.”

[bookmark: _Toc402880322]Other SCS Static Management Program (SMP) Admin features
[bookmark: _Toc402880323]Connecting to SMP servers
SMP is a client/server system typically consisting of one server and ay number of clients, but it is not limited to single server! Even though most companies will have only one server on site where sensors are located, it is also possible to have multiple sites covered. If, for example, there are more LANs, each containing sensors, then each of them may contain a local SMP Server.
SMP client applications (Admin and Client) can easily switch servers. The main application toolbar contains the [image: D:\Doc\Documents\Work\3M\DMS Documentation\User Guide\tbcommand06.png] button which is used for this purpose.
	TIP

	Server definition and selection is available in both SMP Admin and SMP Client.
It has the same icon and functionality in both applications.



Defining SMP server connection parameters, connecting to, and switching between servers is covered in full detail in the SMP Users Guide document.
[bookmark: _Toc402880324]Inspecting active connections
The SMP Installation Guide document described how the SMP Server Monitor application can show a list of active device connections. It is also possible to review this list from any remote computer (client) using  the SMP Admin application.
The main toolbar contains the [image: ] button  which brings up a form containing information about all of the active connections:
[image: ]
[bookmark: _Toc402880325]Editing problem solution hints
The SMP Client application assists in problem troubleshooting by presenting common tips and suggesting standard actions. Troubleshooting common problems is described in detail in the SMP Users Guide document.
It is possible to use SMP Admin as a simple editor for those hints. The main command toolbar contains the [image: ] button that brings up this simple editor:
[image: ]
The SCS Static Management Program (SMP) supports only Modbus devices at the moment, so only the Modbus catalog is available for selection. This will change in the future as new device types are added to SMP.	Comment by Carolyn Garber: Trademark?  If so, please make sure it has been properly attributed here and on the final legal page. 
The Problem dropdown contains a list of problems that have solution tips assigned. The picture above shows solution hints for operator resistance related problems.
The main part of the form contains a table with a list of solution hints.  It is possible to:
· change tip – select the text and make the desired edits
· delete tip – click on the row selection bar and press the Delete key
· add new tip – click on the last (empty) row in the table and type text
Edits are not saved automatically – to save all of the edits click on the Update button.

[bookmark: _Toc402880326]Inspecting inactive devices
SMP server will auto-discover all active connected sensors and start data acquisition. If a device is not connected or active (turned off, damaged, disconnected from hub or network, etc.) it will still remain in the system (database), but will not be “visible” in SMP Client.
It is easy to check for such devices by clicking on the [image: ]button on main toolbar. It will show a form:
[image: ]
This form shows a list of all inactive devices with relevant information.
	TIP

	The inactive devices list is available in both SMP Admin and SMP Client.
It has the same icon and functionality in both applications.



[bookmark: _Toc402880327]Administrative actions auditing
It is possible to require user comments for every administrative action that changes the SCS Static Management Program (SMP) configuration. Those actions are:
· device configuration (or copy)
· device calibration (or copy)
· attaching a device to a line
· detaching a device from line
· renaming a device
If the Requires Comments option is set for the server then any of the above actions will bring up the form:
[image: ]
	TIP

	Require Comments only has effect if the Require Authentication option is also on. If the security option is off then SMP won’t ask for comments or record any actions.


It is also possible for system admin to review history of administrative actions. The main application toolbar has a command Administrative Actions Report [image: ]for that purpose. The admin is first presented with a form to define report criteria:
[image: ]
The administrative actions report looks like:
[image: ]
It is also possible to change the filter criteria using the filter button in the top right corner of the form.
[bookmark: _Toc402880328]Surveying and Planning Device Deployment
SCS Static Management Program (SMP) Plant Editor is designed to aid in planning device deployment to the client facility. Plant Editor can calibrate drawings to units of measure. Once the plan is calibrated with real units it becomes easy to position items at exact locations, measure distances, etc.
Let’s demonstrate these capabilities using an example of a plan measured in Metric units.


Plant editor uses Imperial units (inches) as default.
	TIP

	New plans are not calibrated by default (meaning 1 pixel = 1 inch). This is also true even after importing an existing background image. The plan has to be explicitly calibrated.



Units of measure are changed / set using Tools -> Plan Units.
To calibrate the above plan we:
· turn off the grid by setting the ShowGrid property to false
· change the units to metric with Tools -> Plan Units: Metric
· zoom in on the plan to show the left office wall in more detail
· click on the Calibrate tool


The status bar shows the hint:
Click on the plan to define calibration points (distance to measure)
Clicking on two points known to be 23 cm apart brings up a pop-up allowing us to define distance:


Having done this we effectively finish the plan calibration. From this point on, coordinates in status bar will indicate distances in centimeters from top left corner of the plan.

We can now zoom out and show the grid again. Pale red grid lines are now one meter apart. If we used Imperial units, the grid lines would be one foot apart.
To measure distances on the plan we use the Measure Distance tool. For example, to measure the distance between two ceramic tiles in the Reception room we click on the respective points and we get the information as shown on:
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